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What's In My Lunch? 
Quantitative Milk Allergy ELISA
Experiment Objective:

In this inquiry-based experiment, students will master the concepts and methodology 
behind the enzyme-linked immunosorbent assay (ELISA). Students will perform an ELISA 
to detect the presence of whey protein in various food products. A standard curve will be 
created to quantify the concentration of whey in each sample.

See page 3 for storage instructions.
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Experiment Components

COMPONENTS Storage Check (√)

A 10x Dilution Buffer 4°C  Refrigerator ❑
B Whey Antigen   4°C  Refrigerator ❑
C 10x PBST (Wash Buffer) 4°C  Refrigerator ❑
D   Primary Antibody 4°C  Refrigerator ❑
E Secondary Antibody 4°C  Refrigerator ❑
F Aminosalicylic Acid 

 (Peroxide Co-Substrate) 4°C  Refrigerator ❑
G Hydrogen Peroxide  4°C  Refrigerator ❑

REAGENTS & SUPPLIES  Check (√ )
Store all components below at room temperature

• Microtiter plates  ❑
• Snap-top Microcentrifuge tubes   ❑
• Homogenization pestles with tubes  ❑
• 15 ml conical tubes  ❑
• 50 ml conical tube  ❑
• Transfer pipets  ❑

Experiment #266 is 
designed for 10 lab 
groups. 

• Various food samples to be tested

• Distilled or deionized water

• Beakers or fl asks

• Paper towels

• 37°C Incubator

• Disposable lab gloves

• Safety goggles

• Automatic micropipets (5-50 μl, 100-1000 μl) and tips 

• Digital camera or Cell phone with camera 

• Computers with Internet, image analysis program, and graphing program 

All experiment components 
are intended for educational 
research only.  They are not 
to be used for diagnostic or 
drug purposes, nor admin-
istered to or consumed by 
humans or animals.

Requirements  (not included with this kit)

NOTE:
Disposable micro transfer 
pipets can be substituted 
for automatic micropipets 
if necessary. See Cat. #632.
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UNDERSTANDING ALLERGIES

Allergies are one of the most common diseases of the immune system, 
occurring in up to 20% of people in developed countries. An allergic 
response occurs when the immune system overreacts to a foreign 
material, known as an antigen (short for antibody generator). Common 
antigens for allergy sufferers include infectious agents, such as bacteria 
or viruses, chemicals and various environmental materials such as pol-
len and food. Once an antigen enters the body it triggers white blood 
cells to produce antibodies, leading to a swift immune response.
Antibodies are specialized proteins that are used by the body to identify 
and eliminate pathogens. Each antibody is composed of four polypep-
tide chains, two heavy chains and two light chains. These chains are 
linked together by disulfi de bonds to create a distinct “Y” shape (Figure 
1). At each tip of the Y is a highly variable region composed of 110-130 
amino acids that gives the antibody its specifi city for binding to anti-
gens. Each antibody molecule can bind to two antigen molecules, one 
at each tip. This binding neutralizes the antigen and forms an insoluble 
complex through a process known as immunoprecipitation. 

All allergies begin with sensitization, which starts when a normally 
non-hazardous antigen enters the body and encounters a lymphocyte cell (Figure 2A). For reasons still being researched, the 
lymphocyte cell registers this non-harmful particle as threatening, which triggers the production of novel immunoglobulin E 
(IgE) antibodies (Figure 2B). The highly specifi c IgE antibodies then attach themselves to immune cells, like mast cells and baso-
phils, which circulate throughout the body (Figure 2C). The sensitization process can take between 6-10 days. After sensitization, 
IgE antibodies in the bloodstream can rapidly bind to their antigen, triggering immune cells to release mediator compounds 
such as histamine and proteoglycans into the body (Figure 2D). Once a person has become sensitized, small amounts of the 
antigen can trigger a full allergic reaction.  Symptoms of an allergic reaction are varied, ranging from sneezing and itchy eyes to 
anaphylaxis (Table 1). 

Anaphylaxis is a severe, whole-body reaction to an allergen. French scientists Charles Richet and Paul Portier coined the term 
in 1902 while studying the toxin produced by the tentacles of the Portuguese Man of War. They isolated the toxin to inject into 
dogs hoping to obtain protection, or “prophylaxis”, against it. However, they were horrifi ed to fi nd that even small doses of the 
toxin resulted in the rapid onset of breathing diffi culty in vaccinated dogs. Richet and Portier rightly concluded that the initial 
exposure caused the dog’s immune system to become hyper-sensitized to the toxin. After the fi rst exposure, re-exposure to the 
same compound resulted in a severe reaction, regardless of the dosage. They termed this state “anaphylaxis”, which means 
“against protection”. 

Background Information

Figure 1:  Structure of an antibody
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Figure 2:  The process of allergy sensitization.
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The leading cause of anaphylaxis in humans is related to the food we eat. Food allergies are a serious and growing health issue 
that affects around 15 million people in the United States alone. For example, Cow’s Milk Protein Allergy (CMPA) is the most 
common food allergy in children. CMPA results when the immune system mistakenly attacks one or more milk proteins present 
in food products. The immune response can be immediate (within minutes), delayed (within hours to days), or both. Common 
symptoms include vomiting, wheezing, and eczema (a detailed list is provided in Table 1).

Between 2 to 3% of the general population are diagnosed with CMPA, although many (79%) outgrow it by the age of 16. For 
sufferers, the main treatment for this condi-
tion is to eliminate cow’s milk protein from 
their diet. Most milk is around 3% protein, 
which can be classifi ed into two categories 
based on the presence or absence of the ele-
ment phosphorus. Caseins contain phosphorus 
and will coagulate or precipitate at a pH of 
4.6. This coagulation at reduced pH is the 
basis for cheese curd formation. Most mam-
mal species contain 3 or 4 different casein 
proteins, which make up approximately 82% 
of the total protein in milk. All other proteins 
found in milk lack phosphorus and are grouped together as whey or serum proteins. The major whey proteins in cow milk are 
beta-lactoglobulin and alpha-lactalbumin. Together, the whey proteins comprise the remaining 18% of protein in milk.

DETECTING FOOD ALLERGENS

In 2005 the FDA began requiring manufacturers to label the presence/absence of eight of the most common allergens (milk, 
eggs, fi sh, shellfi sh, peanuts, wheat, soybeans, and tree nuts) in their food products. This labeling helps consumers more easily 
identify and avoid potentially dangerous allergens. To detect these allergens in their product, food companies can use PCR, 
mass spectrometry, or immunochemical assays, although immunochemical assays tend to be the most popular due of their 
approachability and robustness. Immunochemical assays identify a particular substance by its ability to bind to an antibody. One 
commonly used immunochemical assay is the Enzyme Linked Immunosorbent Assay (ELISA).

ELISAs can determine the presence and concentration of specifi c antigens in complex solutions. To accomplish this, ELISAs rely 
on the ability of an antibody to recognize and bind to specifi c antigens. Most ELISAs use two different antibodies – a primary an-
tibody that is specifi c to the antigen of interest and a secondary antibody that recognizes the antigen-antibody complex (Figure 
3A). This secondary antibody is coupled to an enzyme that reacts with a substrate to produce a signal. ELISAs can be designed 
to detect antigens for a large variety of purposes. For example, in medicine ELISAs are often used to determine serum antibody 
concentrations. This information helps doctors to diagnose viral, bacterial, and parasitic infections.  ELISAs can also be used to 
identify genetically modifi ed organisms, trace drug use, and confi rm pregnancy.

Traditional ELISAs are performed in transparent microtiter plates made of polystyrene or polyvinyl chloride. The sample to be 
tested is deposited into small wells and proteins present in the solution, including the antigen under investigation, will stick to 
the plate. These proteins/antigens are allowed to bind to the plate during a short incubation period (Figure 3B). After this the 
wells are washed to remove unabsorbed antigens and a solution that contains the primary antibody is added to the wells. If 
the antigen is present in the wells then it will bind to the antibody and form a complex.

Following a second wash, a solution containing the enzyme-linked secondary antibody is added to the wells (Figure 3B). This 
secondary antibody will bind to the antigen and primary antibody complex.  After a fi nal washing step, a colorless substrate so-
lution (hydrogen peroxide and amino salicylate) is added. If there is any secondary antibody bound to the well then the linked 
enzyme Horseradish Peroxidase (HRP) will convert the hydrogen peroxide to water and oxygen using the amino salicylate as 
the hydrogen donor. Oxidized salicylate is brown and can be easily observed in wells containing the antigen (Figure 3B). 

Since each secondary antibody can produce many molecules of the converted substrate ELISAs are very sensitive, even at 
extremely low levels of antigen. ELISAs can be qualitative, in which case they indicate whether or not an antigen is present, 
or quantitative, in which case they also measure the antigen concentration. A quantitative ELISA requires that several wells 
be set-aside as standards. Each standard will contain a solution where the concentration of the antigen of interest is already 

Immediate Reactions 

Delayed Reactions 

Table 1: Potential Symptoms of an Allergic Reaction

Anaphylaxis, acute rash, wheezing, sneezing, 
congestion, dry cough, vomiting, acute asthma, 
swelling of the larynx

Atopic dermatitis, vomiting and diarrhea, constipation, 
poor growth, inflammation in digestive tract.
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known. The signal intensity in each well is measured and the values of the standards are plotted to create a standard curve. The 
intensity of the unknown samples can then be compared to the standard curve to determine an approximate protein concentra-
tion. Quantitative ELISAs are used in research, medicine, and industry tests. 

In this exploration, students will perform an ELISA to examine the presence of whey protein in various food products. Students 
will also prepare a standard curve containing known amounts of whey protein. This standard curve will be used to estimate the 
concentration of whey in their food samples. As a STEM activity, students will create a standard curve base on image density 
measurements. This exercise will allow students to calculate the amount of whey found in a food sample.  

Figure 3:  Overview of the ELISA.
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EXPERIMENT OBJECTIVE:  

In this inquiry-based experiment, students will master the concepts and methodology behind 
the enzyme-linked immunosorbent assay (ELISA). Students will perform an ELISA to detect the 
presence of whey protein in various food products. A standard curve will be created to quantify 
the concentration of whey in each sample.

LABORATORY SAFETY

1. Gloves and goggles should be worn routinely as good laboratory practice.

2. Exercise extreme caution when working with equipment which is used in conjunction with 
the heating and/or melting of reagents. 

3. DO NOT MOUTH PIPET REAGENTS - USE PIPET PUMPS OR BULBS.

4. Always wash hands thoroughly with soap and water after handling contaminated 
materials. 

LABORATORY NOTEBOOKS:

Scientists document everything that happens during an experiment, including experi-
mental conditions, thoughts and observations while conducting the experiment, and, of 
course, any data collected. Today, you’ll be documenting your experiment in a labora-
tory notebook or on a separate worksheet.

Before starting the Experiment:

• Carefully read the introduction and the protocol. Use this information to form a 
hypothesis for this experiment. 

• Predict the results of your experiment.  

During the Experiment: 

•  Record your observations.

After the Experiment:

• Interpret the results – does your data support or contradict your hypothesis? 
• If you repeated this experiment, what would you change? Revise your hypothesis 

to refl ect this change.

Experiment Overview

Wear gloves 
and safety goggles

Preparation of 
Food Samples 

Module I - 15 min.

Allergen Detection by
ELISA

Qualitative Analysis of
Allergen Testing

Quantitative Analysis of
Allergen Testing

Module II - 45 min.

Module IIIA - 15 min.

Module  IIIB - 45 min.
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Module I: Preparation of Food Samples

The food samples must be diluted to ensure that the concentrations will fall inside the range established by the standard curve. 
Best results are typically obtained using a 1:10 dilution series for the food sample.
1. Using a fi ne-tipped marker, DRAW a box around columns 1-8 and another around columns 9-12.  LABEL the fi rst eight wells 

of the microtiter strip with the numbers 1-8 and the last four wells with the letters A, B, C, D. 
2. LABEL a 15 ml tube with the name of your food sample. Also LABEL four microcentrifuge tubes A,B, C, D for the food 

sample dilutions.
3. ADD 450 μl of Dilution Buffer to each microcentrifuge tube.
4. For LIQUID samples (like milk):
 a. ADD 10 μl of liquid food sample and 10 ml Dilution Buffer to the labeled 15 ml tube to create a 1x103 dilution. Mix 

well.  PROCEED directly to step 6.
5. For SOLID food samples (like cheese):
 a. COMBINE 0.1 g of the food with 500 μl of Dilution Buffer in a microcentrifuge tube. 
 b. Use a pestle to completely MASH food.
 c. ADD 10 μl of the mashed food sample and 10 ml Dilution Buffer to the labeled 15 ml tube to create a 1x103 dilution. 

Mix well.
6. ADD 50 μl of the 103 food 

sample to tube A, mix 
well. ADD 50 μl of the 
104 food sample (tube A) 
to tube B, mix well. Con-
tinue to serially DILUTE 
the remaining samples 
through tube D. 

7.  PROCEED to Module II.

  OPTIONAL STOPPING POINT:
  The experiment can be stopped after step 6 by placing the diluted food samples (tubes A-D) into overnight storage at  

 4˚C. The experiment can be resumed the following day by continuing with Module II.

1. 2.

 1    2    3    4     5    6    7    8    A    B    C   D

LABEL the strip tubes. A B

C D

FO
OD

3.
FO

ODADD
10 μl Food Sample

10 ml Dilution buffer

FOR LIQUID SAMPLES

5a. 6.5b.

COMBINE
0.1 g Food Sample

500 μl Dilution buffer

FOR SOLID SAMPLES

MASH

5c.4.

FO
ODADD

10 μl Food Sample
10 ml Dilution buffer

A B c D
ADD

450 μl Dilution 
Buffer

to each tube

50 μl 50 μl 50 μl 50 μl

103

104 105 106 107

A B C D

FO
OD

Table 2: Food Product Dilutions and Concentrations

 Well A B C D

 Concentration 1:104 1:105 1:106 1:107

 Dilution 50 µl of food sample 50 µl of 1:104 (A)  50 µl of 1:105 (B)  50 µl of 1:106 (C)
  + 450 µl dilution sample + 450 µl sample + 450 µl  sample + 450 µl  
  buffer dilution buffer dilution buffer dilution buffer
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Module II: Allergen Detection by ELISA

A standard curve allows researchers to determine the relationship between two known quantities.  To do this, we will perform 
a 1:3 (3 fold) serial dilution of whey protein to buffer, creating eight samples of known antigen concentration.  After performing 
the ELISA, these samples are used to create a standard curve that establishes the relationship between whey concentration and 
sample color intensity.  

Preparation of Dilutions for Standard Curve:

1. ADD 100 μl Dilution Buffer to wells 2-8 of the microtiter strip.

2. ADD 150 μl of the whey antigen solution to well #1. The antigen is provided at a concentration of 20 μg/ml.

3. PIPET 50 μl from well #1 into well #2.

4. Fully MIX the sample by gently pipetting up and down 5 times.

5. Using the same pipet tip, TRANSFER 50 μl from well #2 into well #3 and MIX as in step 4. Continue to serially DILUTE the 

remaining samples through well #8. 

6. REMOVE and DISCARD 50 μl of the diluted antigen from well #8.

7. ADD 100 μl of the diluted food samples (A, B, C, D) to wells A, B, C, and D. Add the solutions starting with the most dilute 

(well D) and ending with the most concentrated (well A) or change tips between each sample. 

8. CALCULATE the antigen concentrations for each well and RECORD your answers in Table 3. 

Table 3: Standard Dilutions and Concentrations
 Well 1 2 3 4 5 6 7 8
 Dilution --- 1:3 1:9 1:27 1:81 1:243 1:729 1:2187
 Dilution 150 µl of 50 µl of 50 µl of 50 µl of 50 µl of 50 µl of 50 µl of 50 µl of 
 Procedure whey well 1 into well 2 into well 3 into well 4 into well 5 into well 6 into well 7 into
  antigen 100 µl 100 µl 100 µl 100 µl 100 µl 100 µl 100 µl  
   dilution dilution dilution dilution dilution dilution dilution
   buffer buffer buffer buffer buffer buffer buffer
 Concentration 20 µg/ml

 1    2    3    4     5    6    7    8    A    B    C    D

1. ADD 100 μl Dilution Buffer to wells 2-8.

 1    2    3    4     5    6    7    8    A    B    C    D

2. ADD 150 μl Whey Antigen.

 1    2    3    4     5    6    7    8    A    B    C    D

3.

REMOVE 50 μl 
from well #8. 

50 μl

 1    2    3    4     5    6    7    8    A    B    C    D

5.

 1    2    3    4     5    6    7    8    A    B    C    D

6.
50 μl

 1    2    3    4     5    6    7    8    A    B    C    D

4. MIX by pipeting up/down 5X.
TRANSFER 50 μl from well #2 to #3.  

MIX and continue through well #8.

 1    2    3    4     5    6    7    8    A    B    C    D

7. ADD 100 μl 
diluted food samples.

PIPET 50 μl from #1 to #2.
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Removal of Sample and Washing the Wells:

9. INCUBATE for 5 minutes at room temperature.

10. INVERT the microtiter strip over a stack of paper towels to remove the samples. TAP the microtiter strip gently onto a 

fresh paper towel to remove any remaining sample. DISCARD the wet paper towels.

11. Using a transfer pipet, ADD wash buffer to fi ll each well. 

NOTE: To minimize cross-contamination it is important that you avoid spilling buffer into neighboring wells.

12. REPEAT step 10 to REMOVE the wash buffer.

13. Using the same transfer pipet, REPEAT steps 11 and 12 to wash the wells.

  OPTIONAL STOPPING POINT: 
  The experiment can be stopped after step 13 but requires that wash buffer be left in all the wells for overnight  
  storage at 4 °C. The experiment can be resumed up to 24 hours later. Remove the Wash Buffer and continue
   with step 14.

Module II: Allergen Detection by ELISA, continued

9.

 1    2    3    4     5    6    7    8    A    B    C    D

5
min.INCUBATE 10. INVERT onto paper towels. ADD wash buffer to each well.11.

 1    2    3    4     5    6    7    8    A    B    C    D

12. INVERT onto paper towels. REPEAT wash steps 11-12.13.

 1    2    3    4     5    6    7    8    A    B    C    D
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Addition and Removal of Antibodies

14. ADD 50 μl of the primary antibody solution to each well.

15. INCUBATE at 37° C for 5 minutes.

16. WASH the wells twice as in steps 10 through 13.

17. ADD 50 μl of the secondary antibody solution to each well.

18. INCUBATE at 37° C for 5 minutes.

19. WASH the wells twice as in steps 10 through 13.

Addition of Substrate

20. ADD 100 μl of the substrate to all 12 wells. 

21. INCUBATE at 37° C for 5 minutes. 

22. Periodically OBSERVE the plate for color development. If the color is not fully developed in 

well 1 after 5 minutes, INCUBATE for an additional 5 minutes.

23. DOCUMENT results by using a digital camera to take a picture. Placing the microtiter strip 

on a white sheet of paper or a white light box can enhance the contrast between wells.

24. PROCEED immediately to Module IIIA and B: Data Analysis.

Module II: Allergen Detection by ELISA, continued

15. 16.5
min.INCUBATE at 37° C. WASH WASH

 1    2    3    4     5    6    7    8    A    B    C    D

ADD  50 μl primary antibody.14.

 1    2    3    4     5    6    7    8    A    B    C    D  1    2    3    4     5    6    7    8    A    B    C    D
INVERT INVERT INVERT

 1    2    3    4     5    6    7    8    A    B    C    D

WASH WASH
 1    2    3    4     5    6    7    8    A    B    C    D

INVERT INVERT INVERT

 1    2    3    4     5    6    7    8    A    B    C    D

18. 19.5
min.INCUBATE at 37° C. ADD  50 μl secondary antibody.17.

 1    2    3    4     5    6    7    8    A    B    C    D  1    2    3    4     5    6    7    8    A    B    C    D

21. 5
min.INCUBATE at 37° C. ADD  100 μl substrate.20.

 1    2    3    4     5    6    7    8    A    B    C    D  1    2    3    4     5    6    7    8    A    B    C    D

22. 23.OBSERVE for color development. DOCUMENT results.

 1    2    3    4     5    6    7    8    A    B    C    D

NOTE: 
It is important that 
the incubation is 
not allowed to pro-
ceed for too long 
as the reaction can 
saturate.
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Module IIIA: Qualitative Analysis of Allergen Testing

The color intensity of each well refl ects the initial concentration of whey. Color intensity can be estimated by eye and described 
or ranked on a scale of 0 (clear) to 10 (dark reddish brown).  Because the aminosalicylic acid will continue to oxidize it is impor-
tant to complete steps 1 through 3 within fi fteen minutes of completing Module II. Alternatively a picture can be taken of the 
microtiter strip and examined later.

1. Which samples are the darkest?  Which are the lightest?  What does this mean?  How does color intensity relate to the 
concentrations you calculated in Table 3?

2. Observe the food sample dilutions. Did any of them change color? 

3. Do any of the food sample dilutions (wells A through D) closely resemble the standard curve dilutions (wells 1 through 8)? 
Based on this similarity can you estimate the original concentration of whey in the food sample you tested? Remember 
that wells A to D represent food that has been diluted.
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Module IIIB: Quantitative Analysis of Allergen Testing

The color intensity of each well can be determined using densitometry, the quantitative measurement of light absorption. In this 

ELISA the initial concentration of whey determines how many molecules of aminosalicylic acid are oxidized. Oxidized salicylate 

turns the solution brown, which leads to more light absorption. Therefore, by measuring the sample color intensity in the eight 

wells of known concentration, we can establish a relationship between whey concentration and light absorption.  This relation-

ship is described by the equation of the standard curve. Using the equation we can then estimate the original concentration of 

whey in your chosen food.  

1. Calculate the mean gray value and the whey protein concentration for the eight standard curve wells.  

 a. Save the digital image of your results as a JPEG on the computer. 

 b. Open the ImageJ program on your computer.

 c. Go to File > Open and open your image. 

 d. Go to Image > Type > 32 bit. 

 e. Go to Edit > Invert. 

 f. Go to Analyze > Set Measurements and select “mean gray value”. 

 NOTE: In digital images each pixel has a luminance – or light intensity – value which ranges from black (zero inten-

sity) to white (full intensity). In Image J this value is called gray value. The mean gray value is calculated by adding 

all the gray values in a selection and then dividing by the total number of pixels. 

 g. Choose the round selection tool 

and draw a circle around the fi rst 

well. 

 h. Go to Analyze > Measure. A new 

window titled results should ap-

pear. Record the results for “mean 

gray value” in your lab notebook or 

in the table below.

 i. Click back to the digital image of 

your results and use the mouse 

or arrow keys to move the circle 

to next well. Repeat step h for all 

remaining wells.  

 j. Complete Table 4 (at right) using 

the mean gray values and the anti-

gen concentrations from Table 3. 

Table 4: Calculations for the Standard Curve
and Diluted Food Samples

 Well Dilution Mean Gray Whey Protein
   Value Concentration
 1 1:1  20 µg/ml
 2 1:3
 3 1:9
 4 1:27
 5 1:81
 6 1:243
 7 1:729
 8 1:2187
 A 1:104 

 B 1:105 

 C 1:106 

 D 1:107 

NOTE:
Detailed download instructions 

for ImageJ can be found at:
http://rsb.info.nih.gov/ij/download.html

What's In My Lunch? Quantitative Milk Allergy ELISAEDVO-Kit 266

13

1.800.EDVOTEK •  Fax 202.370.1501  •  info@edvotek.com  •  www.edvotek.com

Duplication of any part of this document is permitted for non-profi t educational purposes only. Copyright © 2016 EDVOTEK, 

Inc., all rights reserved. 266.160405

What's In My Lunch? Quantitative Milk Allergy ELISAEDVO-Kit 266



Module IIIB: Quantitative Analysis of Allergen Testing, continued

2. Create a standard curve.

 a. Plot the whey protein concentra-

tion (x axis) against the mean 

gray value (y axis) for each 

standard concentration. 

 b. Draw a best-fi t curve through the 

points in the graph (for best re-

sults we suggest using graphing 

software). Record the equation 

for your curve for use later.

 NOTE:  The best-fi t line may not pass

 through every data point.

3. Determine the concentration of target 

protein in the food samples. 

 a. Find the mean gray values of the 

sample in wells A to D as in step 

1. 

 b. Select a sample with an intensity 

value that falls between the maximum and minimum standard curve values. 

 c. From the Y-axis of the standard curve graph, extend a horizontal line from this absorbance value to the standard curve. 

At the point of intersection extend a vertical line to the X-axis and read the corresponding concentration. Alternatively 

use the equation of the best-fi t 

curve to solve for x given the y 

value (see Figure 5).

Based on your calculations, what is the 

concentration of whey in the tested food 

samples?  Remember that wells A to D 

represent food that has been diluted.

Figure 4:  Plotting a Standard Curve.
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Figure 5:  Determining a Protein Concentration.
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Study Questions

1.  Describe the structure of an IgE antibody protein. What type of cell produces these proteins?

2.  Name and describe two types of milk proteins.

3.  Describe an ELISA reaction beginning with the addition of an antigen and ending with the substrate color change.

What's In My Lunch? Quantitative Milk Allergy ELISAEDVO-Kit 266
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Instructor's Guide

OVERVIEW OF INSTRUCTORS PRELAB PREPARATION:

This section outlines the recommended pre-lab preparations and approximate time requirement to 
complete each pre-lab activity.
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Module 1:  Preparation of Food Samples 

What to do: When: Time Required:

Acquire Food Samples  Before the lab -----

Divide Microtiter Plates Before the lab
 

15 minutes

Module 2:  Allergen Detection by ELISA 

What to do: When: Time Required:

Equilibrate a 37° C 
Incubator  

Day of the lab 15 minutes

Prepare peroxidase 
substrate

During the lab
(15-30 min. before
last incubation)

10 minutes

Prepare and aliquot
reagents

Up to 24 hours before
the lab. Store at 4° C.

20 minutes

Module 3b:  Quantitative Analysis of Allergen Testing 

What to do: When: Time Required:

Obtain a digital camera  Before the lab -----

Install image processing
program

Before the lab -----

Obtain access to 
computers

Before the lab -----



Pre-Lab Preparations 

Acquire Food Samples

A variety of dairy and dairy free products can be tested and you 
can encourage student groups to bring in their own samples. While 
results will vary depending on the brand used Table 5 provides a list 
of suggested products and their general results.

Product Tested

Table 5:  Expected Results from Dairy Products

ELISA Color Change

Cow's Milk Dark
Soy Milk None
Protein Drink Light 
Dairy Coffee Creamer Light
Fresh Cream Light to Dark (depending on brand) 
Dairy Cheese Light
Dairy Yogurt  Light to Dark
Dairy Ice Cream Light to Dark
Dairy Free Yogurt  None
Dairy Free Ice Cream Light
Cookies/Cakes None to Light
Salad Dressing Light
Butter None
Candy bar (nougat) Light
Energy/Protein bar Dark

Divide Microtiter Plates

1. ORIENT the microtiter plates so that the numbers 1-12 are at the 
top (see fi gure, below right).

2. CUT each plate on the dotted lines as shown in the fi gure. Each 
piece will have 12 wells. Each lab group will receive one strip. 

Obtain Digital Camera

For the purposes of this experiment almost all digital cameras, includ-
ing those found on cell phones, can be used. Digital cameras will 
include a USB cable and/or memory cards for transferring the pictures 
to the computers. If you are using a cell phone, the images can be sent 
to an email address.  Many image formats can be used including TIFF, 
GIF, and JPEG. 

Computer Requirements For Module IIIB

In order to perform the quantitative analysis, students will need a computer with image analysis software and a graphing 
program capable of fi nding a best-fi t curve.  A number of programs can be used to compare the intensity of the twelve wells. 
We recommend ImageJ (version 1.49 or newer). ImageJ is an image processing program developed at the National Institute of 
Health. It is in the public domain and so can be freely downloaded and installed. Detailed download instructions and the ap-
propriate ImageJ fi le for your platform can be found at http://rsb.info.nih.gov/ij/download.html. 

In order to run ImageJ, you will need to have Java running on the computer.  Please consult the appropriate technology support 
personnel for your institution for assistance. Numerous graphing programs are available. Alternatively, results can be plotted on 
semi-logarithmic paper and a linear trend line added by hand. 

Removing the Samples and Washing the Wells 

As an alternative to inverting the strips to remove the samples during Module II, students can use a pipet for removing the 
samples and wash buffers. In this case it is important to change tips or transfer pipets between wells to prevent cross-contami-
nation. To reduce waste, tips or transfer pipets can be labeled and reused for the same well in future steps.
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Pre-Lab Preparations - Day of the Lab

MODULES I AND II

Preparation of Dilution Buffer  

1. ADD all of the 10x Dilution Buffer (A) to 180 ml of distilled water. Mix well.

2. DISPENSE 15 ml into small beakers for each of the 10 lab groups. LABEL the beakers as “Dilution Buffer”.  Reserve the 

remaining Dilution Buffer for subsequent steps.

Preparation of Whey Solution for Standard Curve

1. ADD 3 ml of diluted Dilution buffer to the bottle of Whey Antigen (B). Cap and invert the bottle to mix. This is the 20 μg/

ml whey sample for the standard curve.

2. LABEL 10 microcentrifuge tubes “Antigen” and DISPENSE 200 μl of the diluted whey for each group.

Preparation of Wash Buffer

1. ADD all of the 10x PBST Wash Buffer (C) to 270 ml of distilled water. MIX well.

2. RESERVE 30 ml of diluted wash buffer for anti-whey primary antibody and peroxidase substrate preparations. 

3. DISPENSE 20 ml into small beakers for each of the 10 lab groups. LABEL the beakers as “Wash Buffer”.

Preparation of Anti-whey Primary Antibody

1. DISPENSE 700 μl of Primary Antibody (D) into 1.5 ml tubes for each of the 10 lab groups. LABEL the tubes as “Primary 

Antibody”.

Preparation of Anti-IgG Peroxidase Conjugate Secondary Antibody

1. ADD 0.3 ml of diluted Wash Buffer to the Secondary Antibody (E). MIX thoroughly by tapping 

and inverting the tube.

2. ADD 7 ml of Wash Buffer to a 15 ml conical tube.

3. TRANSFER the entire contents of tube E prepared in step 1 to the 15 ml tube prepared in step 2. 

MIX well.

4. DISPENSE 700 μl into microcentrifuge tubes for each of the 10 lab groups. LABEL the tubes as “Secondary Antibody”.

NOTE: Store all reagents at 4° C until needed. Components can be prepared up to 24 hours before needed.

NOTE:
The sample volume of 
the secondary antibody 
is very small - the tube 
can be centrifuged to 
collect the sample at the 
bottom.
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Pre-Lab Preparations - During the Lab

MODULE II

Preparation of Peroxidase Substrate During Lab Experiment

Prepare 15 – 30 minutes before the last incubation:

1. DISPENSE 13.5 ml of diluted Wash Buffer to the 50 ml tube provided.

2. ADD Amino-salicylic acid (F) to the 50 ml tube prepared in step 1. Cap and mix thoroughly by shaking and/or vortexing. It 

is common to see undissolved material remaining and is okay to proceed to the next step.

3. ADD 1.5 ml of Hydrogen peroxide (G). Cap and mix.

4. DISPENSE 1.4 ml into microcentrifuge tubes for each of the 10 lab groups. LABEL the tubes “Substrate”.

For Module I, Each Group should receive:

- 15 ml conical tube
- 4 microcentrifuge tubes
- 15 ml Dilution Buffer
- 1 row of microtiter plate
- Food Sample for analysis
- 1 tube with pestle (for solid foods) 

For Module II, Each Group should receive:

- 200 μl Whey Solution
- 1 large transfer pipet
- Empty beaker for waste 
- 20 ml Wash Buffer
- 700 μl Primary antibody
- 700 μl Secondary antibody
- 1.4 ml Substrate (prepared before the last incubation)
- Paper towels

QUICK REFERENCE:

The substrate is prepared for 
the peroxidase enzyme, which 
is attached to the anti-IgG 
peroxidase conjugate (second-
ary antibody).  

Prepare the substrate 15-30 
minutes before students 
require it for plate develop-
ment (last incubation).
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Below are the results for an ELISA we ran using Vitamin D milk. The results in wells A through D will vary depending on what 
food samples are used. The results in wells 1 through 8 can also vary depending on a number of factors, including incubation 
times, accuracy of pipetting, and background lighting. 

     1   2 3         4         5      6   7          8           A         B           C          D
 

Following the directions from Module III B step 1 the image was modifi ed. For reference we have shown the round selection 
tool around the fi rst well. 

     1   2 3         4         5      6   7          8           A         B           C          D

 

The mean gray values for this ELISA are given in our completed Table 4. 

Experiment Results and Analysis

Table 4: Calculations for the Standard Curve
and Diluted Food Samples

 Well Dilution Mean Gray Whey Protein
   Value Concentration
 1 1:1 165.207 20 µg/ml
 2 1:3 163.486 6.67 µg/ml
 3 1:9 159.111 2.22 µg/ml
 4 1:27 144.114 0.74 µg/ml
 5 1:81 133.631 0.25 µg/ml
 6 1:243 118.459 0.08 µg/ml
 7 1:729 102.436 0.03 µg/ml
 8 1:2187 99.515 0.01 µg/ml
 A 1:104 161.376 5.931033753
 B 1:105 139.004 0.6080918305
 C 1:106 115.311 0.05450055394
 D 1:107 100.051 0.01152634047
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Experiment Results and Analysis

Creating a standard curve according to the instructions in Module III B step 2 resulted in the below graph.

All four of the food sample dilutions fell within the range of the standard curve so any could be used to calculate 
the initial whey concentration in the milk. To illustrate step 3 of Module III we will use well A.

Mean gray scale value of well A: 161.376 

Equation of the line:  y = 9.8225ln(x)+143.89
   y represents the mean gray scale value
   x represents the whey concentration (μg/ml)

Solving for x:    9.8225ln(x)+143.89 = 161.376
   9.8225ln(x) = 17.486
   ln(x) = 1.78019852
   eln(x) = e1. 78019852

   x = e1. 78019852

   x =5.93103373052 which we will round to 5.931

Factoring in the dilution:  5.931 x 104 = 59,310 μg/ml of whey 
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Please refer to the kit 
insert for the Answers to 

Study Questions
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